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Analysis 

Project/Subject Background 

RiseBoro Community Partnership, the client, a non-profit in NYC, seeks to develop its 

workforce by developing online modules for the employees of the agency to learn how to use 

Microsoft Excel.  The agency’s managers and directors use this application. However, the results 

of an internal survey indicated that staff members have a desire to learn Excel.  Conversations 

with the Director of Strategic Initiatives and the Vice President of Human Resources have 

provided insight into the development of what they are terming “RiseBoro University.”  The 

project falls in line with this strategic initiative. 

 

According to the client, within its strategic plan, the project will position the organization for 

future growth.  Managers of the organization are knowledgeable of, and proficient in, Excel.  

The clients’ goals for the staff are to “feel comfortable” with the software; that they should be 

able to input data, perform data analysis, and conduct data management.   The goal of the 

instruction, therefore, is for learners to use Microsoft Excel to develop basic spreadsheets, 

perform calculations, create charts, and find duplicates in an address list. 

 

The instructional strategy to develop eLearning modules is associated with the costs of sending 

an employee to a face-to-face class.  Moreover, offering the learners the opportunity to learn on 

their personal schedule is intended to not take away from the critical aspects of employees’ job 

duties.  

 

Usage of the module can be facilitated through E-learning in a rather simple manner. Modules 

will be developed that present various tools within the program that serve to generate a 

productive workforce.  For this module, consideration must be given that most of the learners are 

beginners or intermediate users of the program.  This would imply a top-down sequencing 

approach with “show me,” “coach me,” “hint” and “show how” buttons as presented by Horton 

(2012). 

 

The IDer/Developer has taught and used Excel for the past 15 years.  In this time frame, his 

students have been primarily at the beginner’s level and who subsequently moved up to the 

intermediate/lower advanced level.  He has used Excel both in his professional career and 

personal life to make organize data and also for budgeting.  

  

Learning Context 

The agency is in the process of developing what they have termed “RiseBoro University” an 

online platform that is currently being used primarily by the Human Resources department to 

conduct their onboarding and the dissemination of related materials.  Learners will be able to 

gain access via the internet.  As such, they will be able to learn on their personal schedule, at any 

location of their choice.  A classical tutorial method. In this method, according to Horton (2012), 

“learners will go through a series of topics, each teaching a more difficult concept or skill.” (p.  

 

Project Scope 

The module will cover basic Microsoft Excel and will focus on four topics: the understanding of 

what is a spreadsheet, cell referencing, data entry, and calculations.  RiseBoro strategic plan for 
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the future is to learn and use Microsoft Excel as a part of their job tasks to facilitate productivity.  

Given this understanding, it is expected the scope of this project to creep long after this course is 

complete.  I expect the module to grow into a full-course with lessons ranging from beginners to 

lower level  

 

RiseBoro is looking to implement Excel training as a part its strategic initiative in the 

development of “RiseBoro University.”  This determination was made following a survey of the 

employees.  The results indicated that the staff had a desire to learn Microsoft Excel. 

 

Excel training will serve to benefit the future growth and development of RiseBoro through the 

professional development of its staff.  Managers will be able to assign tasks to their supervisees 

what they otherwise have had to complete themselves.  Hence, the success of this project will 

relieve them to focus and work on and develop other initiatives. 

 

Front End Analysis 

Client and Other Target Learners  

RiseBoro Community Partnership employees over 600 people.  In conversation with the Director 

of Strategic Initiatives it was learned that they consist of some individuals who have only a GED, 

some have a high school diploma, others have earned an associate or bachelor’s degree, and 

graduate school degree recipients amongst the managers and executive staff.  The course is 

intended for any employee who wants to learn how to use the program.   The IDer/Developer has 

is not privy to the results of the survey that was conducted that establish the need for this project.  

Never-the-less, given that an emphasis was stated on providing an opportunity for learning to 

those who have not learned how to use of the application effectively and efficiently, this module 

will target those employees of the agency who consider themselves to be beginners in Excel. 

RiseBoro intends to open the module to all employees of the agency who have a desire to learn 

Microsoft Excel.  The Director of Human Resources supported the information obtained from the 

Director of Strategic Initiatives; indicating that the education levels of the agency’s employees are 

within the range of non-high school graduates to holders of master’s degrees.  Immediate employees 

who stand to benefit from this course are the administrative assistants and other personnel in a 

similar position of assisting a supervisor.  The Director of Human Resources expressed that she uses 

the application but does not know how to create charts.  This personal challenge on the part of a 

professional serves as an example of an individual in a management position who may benefit from 

the program.   There may be others in this particular category. Most of the learners know how to use 

a computer.  The concern relates to knowledge of business productivity software and in some cases 

as noted above, specific features of the program. 

 

The IDer/Developer interviewed the Director of Human Resources and Coordinator of 

Marketing. Unfortunately, the Director of Strategic Initiatives could not be present at the 

conference; The developer will consult further with both parties to both update and gain further 

information as to their progress in the development of the initiative. 
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Intended Instructions 

This module will be a stand-alone self-paced module.  Participation in the course is on a voluntary 

basis unless mandated by a particular employee’s supervisor.  As such, learners are free to access the 

module on their schedule. 

• What do I plan to include in my instruction? 

Absorb Activities 

Learners will have access to an online glossary containing key vocabulary terms used in the module.  

Horton (2012) expresses that developing a glossary for the uninitiated in the lexicon used in the 

materials makes it nearly compulsory that one is created and disseminated to beginning learners. (p. 

189) According to Horton (2012), “the absorb part orients the learner, sets the context, establishes 

the vocabulary.” (p. 68)  

Learners will also view screenshots of the particular feature used in one specific topic for a particular 

objective.  Screenshots will familiarize the learner with what the application will display. 

The learner analysis indicated that the target learners for this module are beginners.  To take “a good 

first step,” (Horton, 2012, p. 67) the module will also contain audio/video software presentation and 

demonstration. Via synced audio/video instructor presentation Learner will able to view the task 

accomplished step-by-step. Creating this process will allow the instructor to control “the sequence of 

learning experiences” (Horton, 2012, p. 69). The learner will be able to observe the steps while 

listening to the instructor.  Moreover, the learner will be able to pause and rewind the recording if 

necessary.  Horton (2012) states that the learner will be able both hear the voice of the instructor and 

also follow the process of the data entry and mouse usage. 

 

Do Activities 

Functional simulation of Microsoft Excel will be embedded into the module wherein learners will be 

able to practice.  The workbook will contain conditional formatting to indicate to the learner when 

they have inputted the data correctly.  The interactivity of the workbook will also allow learners to 

create a spreadsheet.  Learners will be provided access to practice files that they can use online or in 

locally loaded software. 

 

Connect Activities 

To, according to Horton (2012), “bridge the gap” (p.163) learners will be asked to ponder on a list of 

items printed on a receipt that they may have purchased at the supermarket or department store.  

Through this guided exercise, students will be able to connect the concept of labels, values and the 

calculation of values in their lives.  Horton (2012) expresses the activity should generate in the 

learners an awareness of the application of these concepts in their lives.  (p. 166) 

• Assessment/Practice 

Using an embedded excel workbook developed with conditional formatting, learners will be able to 

practice the lessons directly in the module.  Also, access to additional files will serve as resources for 

practice and references for the learners. 

 

The assessment will be used to determine whether learners have achieved the learning objectives of 

this module.  The current thinking for evaluations is to generate quizzes and simulations of the skills 
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learned in the module.  Horton (2012) expresses that in a simulation, learners can be asked to 

“perform a step in the procedure.” (p. 222) 

 

Via the audio/video recordings, the developer will develop a step-by-step process in consideration of 

the learners who are novices.   The developer will place stop, pause, rewind, and fast forward 

buttons to make possible to review the module as needed.  Additionally, resource files will contain 

numerically identified screenshots of the process. 

 

Course Prerequisites 

This course will require no that the learner be able to use the mouse to select cells and program 

features in addition to the ability to keyboard for data entry. 

 

Assessment Plan 

The developer will embed the embedded functional online Excel worksheet with conditional 

formatting features activated for proper data entry and calculations.  The cells background and 

font colors will change to colors that will indicate to the learner that they have correctly 

accomplished the task.  Additionally, if the learner makes a mistake, the developer plan to 

implement data validation features to guide the learners towards the proper input. 

 

Moreover, with step-by-step numerically identified procedures via screen-shots will move the 

learner towards the objective.  They will realize when they have reached the final step.  They will be 

able to compare their work with the final result both in the module and on the PDF handout which 

they can print. 

 

Learning Environment / Proposed Delivery Method 

 

This lesson will be delivered online on an LMS using audio recordings of the instructions synced 

with video recordings of the steps.  This will provide students with an opportunity to absorb the 

information before hands-on practice in a simulation of the software for those who do not have 

access to the application.  If a learner has the program locally installed he or she may choose to 

practice on their local computer. 

 

Potential Technologies for E-Learning 

For this module there are a number of technologies that could potentially be used for its 

development. 

• Microsoft Excel will be used to develop the original course files.  

• Captivate is used to create simulations 

• SharePoint provides the initial platform where the developer will load the Excel spreadsheets.  From 

there, an embed code is generated that facilitates nondestructive sharing of the workbook on an online 

platform. 

• Camtasia allows the developer to record screen actions in addition to audio of the instructor’s 

narration. ` 

• SnagIt 
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With this program, the developer is able to generate screenshots that will serve to illustrate to the 

learner, where in the program a certain feature of the topic can be found in addition to the images of 

the steps they will follow in multi-step procedures. 

 

ProProfs 

ProProfs provides a “Training Maker”.  This service allows an E-learning developer to create and 

publish courses, develop assessments, get training insights, award certificates, and offers a Learning 

Management System.  ProProfs allows the developer to embed a functional workbook into the 

platform.  This platform also allows for multi-screen delivery. 

 

As a novice to the world of E-Learning development, the developer has limited, but growing 

knowledge of this process and the various applications that can be used to develop online course.  

Having said that, the developer is knowledgeable of PowerPoint, SharePoint. 

 

The module will be best viewed on a personal computer or laptop.  The developer will use ProProfs’ 

platform to deliver the module. 

 

The list below contains websites that can be used to learn how to use the applications that are 

listed within.  These sources of training will be used to gain knowledge of the beginners’ level of 

the program in addition to advanced features of the application.  The  
o Tutorials and/or E-guides on the company pages. 

o Lynda.com provides training on Adobe Captivate, Camtasia. 

o ProProfs provides training on how to use their platform. 

o YouTube tutorials are also available for the developer to learn how to use some of the 

above technologies. 

 

Learning Objectives 

 

The following LO’s are based on the Mager (1997) method. 

 

1) Given a computer and spreadsheet software, (C) learners will identity cell references (B) 

by entering data into the proper cells with no spelling errors (CR) 

 

2) Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) by 

entering labels and values data in the proper cells with no spelling errors (CR) 

 

3) Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) 

and use cell references or the SUM function to perform calculations. (CR) 

 

4) Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) by 

entering labels and values data in the proper cells with no spelling errors calculate totals 

and create a bar and column charts. (CR) 

 

5) Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) by 

entering labels and values data in the proper cells with no spelling errors calculate totals 

and create a pie chart. (CR)



E-LEARNING PROJECT DESIGN AND CONTENT PLANS – FINAL REPORT 8 

Wireframe 

 

 
 

Link to Wireframe 

  

https://mycourses.purdue.edu/courses/1/wl_22224.201830/db/_5733311_1/embedded/WireFrame.png
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Site Map 

 

 
 

Link to site map 
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https://drive.google.com/open?id=19SezAV3956HpCs85VybjZEREouzjSZnA
https://drive.google.com/open?id=19SezAV3956HpCs85VybjZEREouzjSZnA
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Instructional Content and Materials 

 

Homepage (A) 

This is the page that the learner will be provided to begin the process. 

 
The URL to this page is:  https://sites.google.com/site/excelntro/ 

 

Start Page (B) 

The learner enters the LMS through this portal.  

 

https://sites.google.com/site/excelntro/
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Learner Sign-in (C) 

 

 
At this point, the learner is prompted to provide their name in addition to their email address.  

The email address will allow the learner to close out the module and resume where they left off. 

 

Module Overview (D) 

 
Narration:  Welcome to Microsoft Excel for Beginners.  In this course you will learn the 

foundation of Microsoft Excel.  This module contains four lesson structure, data entry, 

calculations, analysis.  If you are new to this program, I suggest that you go through the module 

in order, that you do not skip around.  If you have used Excel in the past and are here for a 

refresher, please feel free to choose a lesson of your liking. 

 

In the Excel structure lesson, you will learn about what it at the foundation of Excel that makes it 

calculate numbers for you.  We will answer the question; What is Microsoft Excel?  This lesson 

will conclude with a clear understanding of cell references. 

 

In the Cell Reference lesson, we will answer the question what is the one thing that makes Excel 

work?  How are cell references identified? 

 

In the Data Entry lesson, you will learn what you can type into the program and create a basic 

spreadsheet  

 

In the AutoSum lesson, you will learn how easy Excel calculates totals on a worksheet.  In this 

lesson the value of cell references will become evident. 

 

The analysis lesson will cover three tools that are used to analyze the worksheet. This lesson will 

introduce you to creating charts in Microsoft Excel. 
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On a note, if time is not on your side, you can exit from the module by closing your browser or 

tab.  The next time you log into the module, you will have the option of continuing where you 

left off. 

 

To start learning, click on the NEXT button at in the upper-right hand or choose the lesson you 

wish to go to from the left side of the screen.  The next page is the handout, you can download 

this document for your reference as you proceed through the module. 

 

Excel Module One (E) 

 
 

This page provides a prompt to students to choose a lesson or click the next button. 

 

Handout (F) 

 
 

Learners are provided with absorb type information that they can download, print, and read 

offline. 
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Excel Structure:  Columns, Rows, Cells (G) 

 
 

Narration:  In this lesson, you will learn the layout of the Excel screen.  In other words, if you 

are wondering what you are looking at when you see an Excel screen.   

 

There are two major parts to the excel interface.  One, columns. They are identified by the letters 

at the top.  I have filled a column in blue in this example. 

 

Two are the rows.  They are identified by the numbers on the left side of the screen.  I have filled 

a row in green in this example. 

Where a column and a row meet is a called cell.  The cell is identified by the column letter and 

the row number.  In this example the cell E8 is filled in yellow.  E8 is the cell reference.  There 

are millions of cells in an Excel worksheet.  In summary it is about columns and rows which 

meet to form cells.  The cells are identified by the column letter and row number.  An easy way 

to remember this is to think about R2 D2 from Star Wars.  This is the end of this lesson on the 

Excel structure.  Click on the NEXT button at in the upper-right hand or choose the lesson you 

wish to go to from the left side of the screen.  The next page is a quiz on columns and rows. 

 

Quiz 

This is an assessment of the learner’s understanding of columns and rows 
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This quiz is intended to measure how well the learner understands concepts of columns and 

rows.  Columns and rows are the foundation of cell references. 

 

Cell Referencing Video (H) 
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Narration:  In this lesson we will have fun will cell references.  You will recall that a cell is 

identified by the column letter (above) and the row number (to the right).  Cell references are 

what allows Excel to calculate the values that we input.  It is what brings out the power of the 

program. The combination of a Column letter and a row number is a cell reference.  For 

example, cell R2 is in column R and row 2.  Cell D2 is in column D and row 2.  Cell G3 is in 

column G and in row 3.   

 

When I think of cell referencing I think about when my friends asked me to meet them on Eighth 

Avenue in midtown Manhattan.  My question for her was Eighth Avenue and what street?  I also 

think about my friend who lives in a high rise.  When I first visited, he told me he lived on the 

15th floor.  Since we were in a typical NYC rush I didn’t get the apartment letter.   

 

You see in both these cases, it takes two bits of information to identify a location.  It could be 

latitude and longitude, street and avenue, floor and door.  The same goes for cell referencing… 

columns and rows. 

 

In this exercise I type the correct cell reference into each cell with a yellow fill, the cell’s color 

will change.  (pause speaking and input cells).   

 

(continue speaking) If I input the wrong cell reference the color will not change.  In summary a 

cell reference is the identity of a particular cell in the Excel grid structure.  Columns are 

identified with letters at the top of the column and rows are identified with the numbers on the 

far left of the screen.  The combination of a column letter and a row number is a cell reference.  

 

This is the end of this lesson on the cell referencing.  Click on the NEXT button at in the upper-

right hand or choose the lesson you wish to go to from the left side of the screen.  The next page 

will allow you to practice what you have learned about cell references. 

 

Cell Referencing Practice (I) 

Here learners are given an opportunity to reinforce their understanding of cell referencing.  I 

have activated conditional-formatting features that will give the learner an indication that they 

have successfully completed the task. 
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Data Entry - Labels and Values (Video) (J) 

 
 

Narration:  What can I type into these cells?  What type of data can they hold.  In a very general 

way there are four types of data that can be typed into these cells.   

 

1) Labels 

2) Values 

3) Numeric Labels 

4) Formulas 

Labels are text entries that identify what a value represents. We just type them, and press enter to 

activate the cell in the next row or to activate the cell the next column (Pause and type 

labels/point out usage of enter and tab key) 
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Values are the actual numbers that are going to be used in our calculations.  Like labels, we just 

type them, and press enter to activate the cell in the next row or to activate the cell the next 

column.  (Pause and type labels/point out usage of enter and tab key) 

 

Numeric labels are numbers that are used to identify a person, place, or thing.  Since both 

numeric labels and values are numbers, what do we do so that Excel will know the difference 

between the two.  Here it is.  When we type a numeric label, we start it with an apostrophe.  That 

key to the left of the enter key on your keyboard.   

 

We will cover formulas in another lesson.  But for now, I will tell you that formulas are what 

make Excel perform the calculations.   

 

This is the end of this lesson on the data entry in Microsoft Excel.  Click on the NEXT button at 

in the upper-right hand or choose the lesson you wish to go to from the left side of the screen.  

The next page will allow you to practice what you have learned about the type of data that can go 

into an Excel worksheet. 

 

Data Entry - Labels and Values (Practice) (K) 

Here learners are given an opportunity to reinforce their understanding of data entry.  I have 

activated conditional-formatting features that will give the learner an indication that they have 

successfully completed the task 
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Calculations – AutoSum Function (Video) (L) 

 
 

Narration: Excel uses what are called formulas to perform calculations of the values or numbers 

that we type into the program.  These formulas use the cell reference of the cell where the 

number is located and uses that instead of the number.  In other words, Excel does not care what 

number is in the cell.  In this lesson, you will learn how to calculate numbers using the AutoSum 

Function.   

 

This is the easiest way to add up a set of values in Microsoft Excel.  Here is the process.  Notice 

the numbers in cells with yellow fill color.  This is a two-step process in the local program.  The 

first step is to select the first set of numbers in yellow.  I will also extend the selection to the 

Total row and Total Column.  Once these cells have been selected, I am going to the find the 

AutoSum command in the Home tab.  It’s located here in the upper-right corner.  I press it once 

and all the answers appear where I have selected.  I will now repeat the process for the items in 

rows nine through eleven. I will select the values I want to calculate and the location where I 

want the answers to appear.  Second, I will go to the Home tab and select the AutoSum 

command.  

 

Let’s look at the one formula to see what Excel did. Let’s look at the totals for cell C5, the totals 

for Store 1.  Notices it reads =SUM(B3:B5)  The “:” in the middle of the cell references means 

“through.”  In other words, it picks up all the cells not indicated in the range.  The key to this 

technique is that there are no empty columns or rows in the selected range.  With this in mind, 

you can also type the formula into the cell.  Pressing enter after typing the formula reveals the 

answer and moves the active cell to the next row.   

 

This is the end of this lesson on the calculations in Microsoft Excel.  Click on the NEXT button 

at in the upper-right hand or choose the lesson you wish to go to from the left side of the screen.  

The next page will allow you to practice what you have learned about performing calculations in 

Microsoft Excel. 
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Calculations – AutoSum Function (Practice) (M) 

Here learners are given an opportunity to reinforce their understanding of performing 

calculations.  I have activated conditional-formatting features that will give the learner an 

indication that they have successfully completed the task 

 

 
 

Bar Charts (Video) (N) 

 
Narration:  Charts are tools used to analyze the data we have typed and the values we have 

calculated.  In this lesson you will learn how to produce a bar chart from the spreadsheet you 

have created.  Excel allows you to produce charts in a few steps.  One you have all your 

spreadsheet complete, select the labels and the values.  I will not select the totals because I do not 

want them to appear in my chart.   

 

After selecting the data, I want to chart, step two is to find the feature that will command Excel 

to do it.  The charts feature in Excel is located in the Insert tab.  Here in the Insert tab, in the 

middle of the ribbon, we find the charts section that starts with Recommended charts.  Hovering 

our mouse over the icons to the left we see “Recommended Charts.”  Scrolling through the 
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recommendation we see where our bar charts are hiding.  I will pick the first one; the clustered 

bar chart.   

 

This is the end of this lesson on creating bar charts in Microsoft Excel.  Click on the NEXT 

button at in the upper-right hand or choose the lesson you wish to go to from the left side of the 

screen.  The next page will allow you to practice what you have learned about creating bar charts 

in Microsoft Excel. 

 

Bar Charts (Practice) (O) 

Students will download this document and do the work on their local computer. 

 

 
 

Column Charts (Video) (P) 

Students will download this document and do the work on their local computer. 

 
 

Narration:  Charts are tools used to analyze the data we have typed and the values we have 

calculated.  In this lesson you will learn how to produce a bar chart from the spreadsheet you 

have created.  Excel allows you to produce charts in a few steps.  One you have all your 
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spreadsheet complete, select the labels and the values.  I will not select the totals because I do not 

want them to appear in my chart.   

 

After selecting the data, I want to chart, step two is to find the feature that will command Excel 

to do it.  The charts feature in Excel is located in the Insert tab.  Here in the Insert tab, in the 

middle of the ribbon, we find the charts section that starts with Recommended charts.  Hovering 

our mouse over the icons to the left we see “Column.”  This is where our column charts are 

hiding.  Clicking on “Column” reveals ten types of column charts.  I will pick the first one; the 

2D column chart.   

 

This is the end of this lesson on creating column charts in Microsoft Excel.  Click on the NEXT 

button at in the upper-right hand or choose the lesson you wish to go to from the left side of the 

screen.  The next page will allow you to practice what you have learned about creating column 

charts in Microsoft Excel. 

 

Column Charts (Practice) (Q) 

Students can download this document and complete the task on their local computer. 
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Pie Charts (Video) (R) 

Students can download this document and complete the task on their local computer. 

 
 

Narration:  Charts are tools used to analyze the data we have typed and the values we have 

calculated.  In this lesson you will learn how to produce a pie chart from the spreadsheet you 

have created.  Excel allows you to produce charts in a few steps.  One you have all your 

spreadsheet complete, select the labels and the values.  Pie charts are different from bar and 

column charts in that they can only handle one series meaning one column or one row of values 

at a time. In this example I will choose the labels in column B and the values from column C.  I 

will also pick up the label in column C. 

 

After selecting the data, I want to chart, step two is to find the feature that will command Excel 

to do it.  The charts feature in Excel is located in the Insert tab.  Here in the Insert tab, in the 

middle of the ribbon, we find the charts section that starts with Recommended charts.  Hovering 

our mouse over the icons to the left we see “Pie.”  This is where our pie charts are hiding.  

Clicking on “Pie” reveals five types of pie charts.  I will pick the first one; the 2D pie chart.   

 

This is the end of this lesson on creating pie charts in Microsoft Excel.  Click on the NEXT 

button at in the upper-right hand or choose the lesson you wish to go to from the left side of the 

screen.  The next page will allow you to practice what you have learned about creating pie charts 

in Microsoft Excel. 
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Pie Charts (Practice) (S) 

Students will download this document and complete the task on their local computer. 
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Assessment (T) 

Objective 1 

 

Given a computer and spreadsheet software, (C) learners will identity cell references (B) by 

entering data into the proper cells with no spelling errors (CR). 

 

Students will download this document, complete the task, save, it, and then upload their finished 

work to the LMS. 

 

 
 

INSTRUCTIONS:  For this practice you have been provided a copy of the file.  Here you will 

enter formulas to calculate the totals for each store, each product and the grand total for all 

stores.  You will need to download the document, complete the task, save it, and then upload it to 

the system. 
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Objective 2 

 

Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) by 

entering labels and values data in the proper cells with no spelling errors (CR) 

 

Students will download this document, complete the task, save, it, and then upload their finished 

work to the LMS. 

 

 
 

INSTRUCTIONS:  For this practice you have been provided a copy of the file.  Here you will 

enter formulas to calculate the totals for each store, each product and the grand total for all 

stores.  You will need to download the document, complete the task, save it, and then upload it to 

the system. 
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Objective 3 

 

Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) and use 

cell references or the SUM function to perform calculations. (CR) 

 

Students will download this document, complete the task, save, it, and then upload their finished 

work to the LMS. 

 

 
 

INSTRUCTIONS:  For this practice you have been provided a copy of the file.  Here you will 

enter formulas to calculate the totals for each store, each product and the grand total for all 

stores.  You will need to download the document, complete the task, save it, and then upload it to 

the system. 
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Objective 4 

 

Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) by 

entering labels and values data in the proper cells with no spelling errors calculate totals and 

create a bar and column charts. (CR) 

 

Students will download this document, complete the task, save, it, and then upload their finished 

work to the LMS. 

 

 
 

 
 

INSTRUCTIONS:  For this practice you have been provided a copy of the file.  Here you will 

enter formulas to calculate the totals for each store, each product and the grand total for all 

stores.  You will need to download the document, complete the task, save it, and then upload it to 

the system. 
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Objective 5 

 

Given a computer and spreadsheet software, (C) learners will develop a worksheet (B) by 

entering labels and values data in the proper cells with no spelling errors calculate totals and 

create a pie chart. (CR) 

 

Students will download this document, complete the task, save, it, and then upload their finished 

work to the LMS. 

 

 
 

 
 

INSTRUCTIONS:  For this practice you have been provided a copy of the file.  Here you will 

enter formulas to calculate the totals for each store, each product and the grand total for all 

stores.  You will need to download the document, complete the task, save it, and then upload it to 

the system. 
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Self-Evaluation 

 

Stage Criteria Explanation 

PROBLEM 

Is the courseware presented in 

the context of real world 

problems? Yes 

Does the courseware show 

learners the task they will be 

able to do or the problem they 

will be able to solve as a result 

of completing a module or 

course?  Yes 

 The courseware presents 

basic problems that may arise 

in an office environment 

regarding inventory.  Tasks in 

the module present this real-

world issue to the learners 

and provides solutions.  The 

courseware provides 

scaffolding of the information 

such that the learners at the 

end have built a spreadsheet 

and performed at least two 

analyses on it. 

 Are students engaged at the 

problem or task level not just the 

operation or action levels? Yes 

 Does the courseware involve a 

progression of problems rather 

than a single problem? Yes 

RATING FOR PROBLEM STAGE: Gold 

ACTIVATION 

Does the courseware attempt to 

activate relevant prior 

knowledge or experience? Yes 

Does the courseware direct 

learners to recall, relate, 

describe, or apply knowledge 

from relevant past experience 

that can be used as a foundation 

for new knowledge? Yes 

The module assumes that the 

learners are not totally new to 

the application taught in the 

lessons.  If learners have used 

any word processing 

software, they are familiar 

with typing labels.  The 

courseware is built with the 

express intention of a 

foundation upon which 

learners can gain new 

knowledge and skills.  This 

module scratches the scratch 

on the surface of the 

application.  The lesson on 

cell references does a good 

job of helping learners relate 

to a two-point system to 

finding a place, be it a 

geographic location in a 

major city or an apartment in 

a high-rise in the same city. 

 Does the courseware provide 

relevant experience that can be 

used as a foundation for the new 

knowledge? Yes 

 If learners already know some of 

the content are they given an 

opportunity to demonstrate their 

previously acquired knowledge 

or skill. Yes 

RATING FOR ACTIVATION STAGE: Gold 
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Stage Criteria Explanation 

DEMONSTRATION 

Are the demonstrations 

(examples) consistent with the 

content being taught? Yes 

Are the demonstrations 

(examples) consistent with the 

content being taught?  

• Examples and non-examples 

for concepts? 

• Demonstrations for 

procedures? Yes 

• Visualizations for processes? 

No 

• Modeling for behavior? 

 

 

The courseware is presented 

within the context of a real-

world problem. 

 

The solution to the problem is 

realistic. 

 

Learners are directed to 

external resources to obtain 

more information and practice 

on the content being taught. 

 

The media used in the 

courseware is relevant to the 

content.   

 Are at least some of the 

following learner guidance 

techniques employed? 

• Learners are directed to 

relevant information? 

• Multiple representations are 

used for the demonstrations? 

• Multiple demonstrations are 

explicitly compared? Yes 

 Is media relevant to the content 

and used to enhance learning? 

Yes 

RATING FOR DEMONSTRATION STAGE: Gold 

APPLICATION 

Are the application (practice) 

and the posttest consistent with 

the stated or implied objectives? 

Yes 

Are the application (practice) 

and the posttest consistent with 

the stated or implied objectives? 

• Information-about practice 

requires learners to recall or 

recognize information. Yes 

• Parts-of practice requires the 

learners to locate, name, and/or 

describe each part. No 

• Kinds-of practice requires 

learners to identify new 

examples of each kind. No 

• How-to practice requires 

learners to do the procedure.  

Yes 

• What-happens practice 

requires learners to predict a 

consequence of a process 

given conditions, or to find 

faulted conditions given an 

unexpected consequence.  No 

The courseware maintains 

congruence between the 

practice and the assessment.  

Learners are required to apply 

the skills they learned in the 

assessments. Learners will be 

required to re-call some of the 

details that were stated in the 

narrations.  Learners are 

expected to be able to locate 

the charts feature and the 

AutoSum feature to complete 

the practice and assessments.  

 

Learners are required to 

notice their data entry and the 

selection process when 

creating charts.  If they select 
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Stage Criteria Explanation 

 Does the courseware require 

learners to use new knowledge 

or skill to solve a varied 

sequence of problems and do 

learners receive corrective 

feedback on their performance? 

No 

incorrectly, the chart will not 

be generated as they desire. 

 

The module is not currently 

set up for learners to access 

context sensitive data, nor is 

there any type of coaching at 

the moment set-up with the 

module. 
 In most application or practice 

activities, are learners able to 

access context sensitive help or 

guidance when having difficulty 

with the instructional materials? 

Is this coaching gradually 

diminished as the instruction 

progresses? No 

RATING FOR APPLICATION STAGE: Silver 

INTEGRATION 

Does the courseware provide 

techniques that encourage 

learners to integrate (transfer) 

the new knowledge or skill into 

their everyday life? Yes 

Does the courseware provide an 

opportunity for learners to 

publicly demonstrate their new 

knowledge or skill? Yes 

The courseware provides for 

an opportunity for learners to 

download certain files, 

complete those tasks on their 

local computer and share their 

work with others, including 

their co-workers and 

supervisors. 

 

There is no discussion board 

provided in the courseware 

where learners can reflect on 

their experience. 

 

Within the courseware, it is 

suggested that students 

change the data within the 

spreadsheet to any text  

  

 Does the courseware provide an 

opportunity for learners to 

reflect-on, discuss, and defend 

their new knowledge or skill? 

No 

 Does the courseware provide an 

opportunity for learners to 

create, invent, or explore new 

and personal ways to use their 

new knowledge or skill? Yes 

RATING FOR INTEGRATION STAGE: Bronze 
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Final Report 

Digital Prototype: 

https://sites.google.com/site/excelntro/ 
 

Formative Evaluation: 
Formative evaluations were conducted with the client to determine the usability of the module 

from the homepage through the assessment.  The IDer/Developer also conducted formative 

evaluations using a staff member that would likely take the course.  

 

The client liked the module.  The first thing that was noticed was the logo placed in the upper left 

corner of the page.  This corporate branding of the module was important to the client.  

Familiarity with the logo will give the learners a sense of official recognition from the agency 

that the course is approved by the client.  Going through the pages, the client noted the simplicity 

of navigating through the page.  This seemed to be more of an interest than completing the 

module at the moment.  The client agreed that the assessments sufficed to determine if the 

learners have met the learning objectives. 

 

In regard to the look of the site, the developer chose the colors of the page to reflect the colors of 

the logo in order to maintain a sense of continuity and not have any distracting elements.  There 

is an image in the background of the page.  The developer was asked why that image was 

chosen.  Not that it is a bad image, it was out of curiosity.  It’s a theme image 

within google sites.   

 

Overall, the client expressed approval of the module.  She liked the simplicity of the lessons and 

that the videos are not long.  

 

The developer also conducted a usability test with a co-worker. 

 

Prior to commencing the usability test, the developer briefed the volunteer, a co-worker about the 

project, giving him basic information about the project; that it was a Microsoft Excel course.  He 

had previously expressed his interest in learning how to use the program, but his time was very 

limited due to his job and personal responsibilities.  He is a case manager and mainly utilizes 

programs that are text heavy and not calculation oriented.   However, he has a private business 

doing home-repair on the weekends.  For this reason, the developer asked him to participate in 

this testing.  It was good that he agreed. 

 

When he entered the homepage, the volunteer realized from the homepage that the course is 

free.  He briefly looked at the text on the page while moving the mouse to the link to begin the 

course.  He immediately clicked on the link to enter the LMS.  He entered the necessary 

information to begin the process.  

 

The volunteer was more interested in the videos.  The developer noted that he clicked on the full-

screen feature to view the video.  This was good because the video is in high definition.  He did 

practice the cell reference exercise after viewing the video. 

 

https://sites.google.com/site/excelntro/
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During the cell reference video, the volunteer requested that the developer include an example of 

how cell reference applies in the recording.  This was a good idea that the developer will 

implement. 

 

What surprised you in their feedback? 

As the volunteer was going through the module he mentioned a few things that the developer 

noted.  During the cell referencing video he said, “this is the basics, the rest will come 

later.”  Also, after watching the “AutoSum” video, he stated, “that was easy.”  the developer 

would have liked for him to do the practice exercises, but time was limited.  

 

After watching the videos, the volunteer made the connection with Excel calculations to his 

small business.  Moreover, he spoke about how he can use Excel to create a budget and to 

determine what he charges his clients based on factors related to his business.  

 

What changes are you considering implementing? Please explain. 

 

The developer will implement the usage of cell referencing in the related video.  On one of the 

videos, I am thinking about enhancing the audio or re-recording the narration.  Relative to the 

other audio recordings, the one in question has a different feel to it.  

 

The developer will pluralize the term “course” link. 

 

Are there things you will likely not change? If yes, what are they and why will they remain 

the same? 

 

Homepage 

The homepage works well for the project.  It is simple, yet professional in its display.  There are 

few links, so the user should not get confused navigating the page. 

 

LMS 

The LMS platform that I am using, proprofs.com contains the required technology to host the 

module 

 

Videos 

The video recordings are all high definition with enhanced audio. 

 

Practice options 

The practice options in the LMS are downloadable if the learner prefers to work on the exercises 

within Excel as opposed to the embedded sheet.  In the case of the charts, the learner is required 

to use their installed version of Excel to complete the exercise.  

 

Assessments 

Within the LMS, the assessments are graded.  The only aspect of the technology that limits the 

grading of the assessment related to the objectives of using the program directly.  Something that 

would be easy to see in a face-to-face experience.  This aspect of the assessment is dependent on 
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student honesty in completing and uploading their finished document to the LMS wherein it will 

have to be “eyeballed” for grading purposes. 
 

Experiences Report: 
This experience of creating this courseware was valuable to me and my professional development.  

Starting with the decision on what to do for this project and then determining the learning objective.  

These steps were relatively straightforward.  I had no complications in achieving the objectives. 

When it came to the wireframing process, I found a bit challenging since it was new to me.  It was 

my first time creating such material.  After I got through that process things got a lot easier.  Once I 

understood what it was and what I was doing my art background kicked in and I was able to get a 

grasp of the full picture of what I was developing.  Creating the storyboard was easy once the 

wireframe was finished.  It allowed me to visualize the order in which the users would go ideally 

navigate the site to accomplish the learning objectives. 
 

I did run into technical issues.  It was my intention to develop videos in Camtasia 3.  When I played 

around with the program, I became aware of the difficulty to generate the .mp4 file type that I need to 

upload to YouTube.  I resolved this issue by using Live Screen Capture to record the videos and 

Adobe Premiere Pro to edit them.  This experience let me know that one is not limited to the 

established technologies that are promoted to developers of eLearning materials. 

 

The fun and at times frustrating aspect was the narrations; frustrating because of the constant errors 

that I was making.  It was also fun because it was a new experience that allowed me to practice a 
voice over skills. 

 

The usability testing and formative evaluations were key to the success of the completion of the 

project.  Getting honest feedback from others helped me see things that had not come to mind.  The 

difference in what the evaluators focused on; style, navigation, and content made me revisit aspects 

of the home page in particular that served to make it easier for the learner to move through the course 

seamlessly. 
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Self-Evaluation: 
 

Stage Criteria Explanation 

PROBLEM 

Is the courseware presented in 

the context of real world 

problems?  

Does the courseware show 

learners the task they will be 

able to do or the problem they 

will be able to solve as a result 

of completing a module or 

course? Yes 

The courseware contains 

videos that serve as absorb 

activities that demonstrates 

the steps to achieve a 

respective goal. 

 

Do activities in the module 

allow students to practice 

what they have learned in the 

absorb activities.  

 

The courseware is scaffolded 

to build skills hierarchically if 

the learners follows the 

module sequentially. 

 Are students engaged at the 

problem or task level not just the 

operation or action levels?  Yes 

 Does the courseware involve a 

progression of problems rather 

than a single problem?  Yes 

RATING FOR PROBLEM STAGE: Gold 

ACTIVATION 

Does the courseware attempt to 

activate relevant prior 

knowledge or experience?  

Does the courseware direct 

learners to recall, relate, 

describe, or apply knowledge 

from relevant  past experience 

that can be used as a foundation 

for new knowledge?  Yes 

In the courseware, the cell 

reference video provides a 

metaphor (first and last name) 

that learners can apply to 

recollect this concept. 

 

The course is based on the 

development of skills that 

will serve as pre-requisites for 

further learning of Excel 

features. 

 

The module allows learners to 

choose the lesson they desire 

to experience. 

 Does the courseware provide 

relevant experience that can be 

used as a foundation for the new 

knowledge?  Yes 

 If learners already know some of 

the content are they given an 

opportunity to demonstrate their 

previously acquired knowledge 
or skill. Yes 

RATING FOR ACTIVATION STAGE: Gold 
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Stage Criteria Explanation 

DEMONSTRATION 

Are the demonstrations 

(examples) consistent with the 

content being taught?  

Are the demonstrations 

(examples) consistent with the 

content being taught?  

• Examples and non-examples 

for concepts? 

• Demonstrations for 

procedures? 

• Visualizations for processes? 

• Modeling for behavior? Yes 

The courseware contains 

videos that demonstrate the 

procedures that students will 

follow to achieve the learning 

objectives.  

 

In the summary section of the 

module, learners are provided 

with resources for further 

learning. 

 

The module utilizes videos 

embedded from YouTube in 

which the steps are 

demonstrated for the learner 

to follow or note. 

 Are at least some of the 

following learner guidance 

techniques employed? 

• Learners are directed to 

relevant information? 

• Multiple representations are 

used for the demonstrations? 

• Multiple demonstrations are 

explicitly compared? No 

 Is media relevant to the content 

and used to enhance learning? 

Yes 

RATING FOR DEMONSTRATION STAGE: Silver 

APPLICATION 

Are the application (practice) 

and the posttest consistent with 

the stated or implied objectives? 

Are the application (practice) 

and the posttest consistent with 

the stated or implied objectives? 

• Information-about practice 

requires learners to recall or 

recognize information.  

• Parts-of practice requires the 

learners to locate, name, and/or 

describe each part.  

• Kinds-of practice requires 

learners to identify new 

examples of each kind.  

• How-to practice requires 

learners to do the procedure.  

• What-happens practice 

requires learners to predict a 

consequence of a process 

given conditions, or to find 

faulted conditions given an 

unexpected consequence.  

The courseware contains non-

destructible embedded Excel 

sheets that the learner can use 

to practice the skills learned 

throughout the module. These 

how-to practice exercises 

serve to reinforce the 

concepts and steps to achieve 

the learning objectives.   



E-LEARNING PROJECT DESIGN AND CONTENT PLANS – FINAL REPORT 37 

Stage Criteria Explanation 

 Does the courseware require 

learners to use new knowledge 

or skill to solve a varied 

sequence of problems and do 

learners receive corrective 

feedback on their performance? 

No 

 In most application or practice 

activities, are learners able to 

access context sensitive help or 

guidance when having difficulty 

with the instructional materials? 

Is this coaching gradually 

diminished as the instruction 

progresses? No 

RATING FOR APPLICATION STAGE: 

INTEGRATION 

Does the courseware provide 

techniques that encourage 

learners to integrate (transfer) 

the new knowledge or skill into 

their everyday life? 

Does the courseware provide an 

opportunity for learners to 

publicly demonstrate their new 

knowledge or skill? 

No 

The courseware does not 

contain a discussion board 

wherein learners can publicly 

display their documents.  This 

lack of a discussion board 

also impedes the learner from 

an opportunity to interact 

with peers. 

 

It is highly suggested that the 

learners use the skills and 

knowledge from the module 

in their personal and 

professional life.   

 Does the courseware provide an 

opportunity for learners to 

reflect-on, discuss, and defend 

their new knowledge or skill? 

No 

 Does the courseware provide an 

opportunity for learners to 

create, invent, or explore new 

and personal ways to use their 

new knowledge or skill? Yes 

RATING FOR INTEGRATION STAGE: Bronze 
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Rubric 

 

Criteria 
Ratings Score 

Comments 
Excellent Satisfactory Wanting /30 

The Digital Prototype 

Content The e-Learning 
lesson contains all 
the necessary 
content to help 
students achieve all 
five objectives. 
 
All topics have a 
series of absorb, do, 
connect and 
assessment 
activities (may be 
combined when 
necessary).  
Content in your 
module is provided 
in an organized and 
logical manner. 
(5 points) 
 

The e-Learning 
lesson is missing 
some content that is 
necessary to help 
students achieve all 
five objectives, 
some of the topics 
lack absorb, do, 
connect and/or 
assessment 
activities (or there is 
no indication of 
activities that are 
somehow 
combined).  
Some of the content 
is not provided in an 
organized or logical 
manner. 
(1-4 points) 

The e-Learning lesson 
does not contain most 
of the necessary content 
to help students achieve 
all five objectives. None 
of the topics have a 
series of absorb, do, 
connect and assessment 
activities (and there is 
no indication of 
activities that are 
somehow combined). (0 
points)  

/5  

Presentation 
of Content 

The e-Learning 
lesson implements 
design 
recommendations 
regarding color, 
screen layout, 
design elements 
and type. If video 
and/or audio are 
provided, they are 
of excellent quality. 
(5 points) 

Some parts of the e-
Learning lesson do 
not implement 
design 
recommendations 
regarding color, 
screen layout, 
design elements 
and type. If video 
and audio are 
provided, there are 
issues with the 
quality of these 
items. (1-4 points) 

No part of the e-
Learning lesson 
implements design 
recommendations 
regarding color, screen 
layout, design elements 
and type. If video and 
audio are provided, they 
are of poor quality. (0 
points)  

/5  

Navigation/ 
Functionality 

Navigation 
throughout the 
entire lesson is 
consistent, 
predictable and 
implements best 
practices related to 
the type of 
navigation 
mechanism used. 
Throughout the 
lesson, there are no 

Navigation in some 
parts of the lesson is 
inconsistent, or 
unpredictable or 
does not implement 
best practices 
related to the type 
of navigation 
mechanism 
Throughout the 
lesson, there are 
some dead links, 

Navigation throughout 
the entire lesson is 
inconsistent, 
unpredictable and does 
not implement best 
practices related to the 
type of navigation 
mechanism used.  
Throughout the lesson, 
all links are dead, 
documents do not open 
or do not display the 

/5  
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Criteria 
Ratings Score 

Comments 
Excellent Satisfactory Wanting /30 

dead links, all 
documents open 
and display the 
expected content, 
all media files 
display/play/open. 
(5 points) 

some documents do 
not open or do not 
display the expected 
content, some 
media files do not 
display/play/open. 
(1-4 points) 

expected content, no 
media files 
display/play/open.  
(0 points)  

The Final Report 

URL and Login 
Information  

The URL and 
necessary login 
information are 
provided to the 
module. (2 points) 

URL is not provided, the login information is not 
provided, or the login does not work. (0) 

/2  

Formative 
Evaluation 

The formative 
evaluation section 
includes a summary 
of the results of the 
formative 
evaluation from 
your client and if 
you can other 
reviewers, an 
explanation of 
necessary changes 
and a rationale for 
when changes are 
inappropriate (if 
applicable). (5 
points) 

The formative 
evaluation section 
does not include a 
summary from your 
client and any other 
reviewers, does not 
include review of 
the changes to be 
made or an 
explanation of 
necessary changes 
or a rationale for 
when changes are 
inappropriate (if 
applicable). (1-4 
points) 

The formative 
evaluation section does 
not include a summary 
of the results of the 
formative evaluation, an 
explanation of necessary 
changes and a rationale 
for when changes are 
inappropriate (if 
applicable). (0 points)  

/5  

Report The report 
addresses all 
required questions. 
(5 points) 

The report does not 
address some of the 
required questions. 
(1-4  points) 

The report does not 
address any of the 
required questions. (0 
points) 

/5  

Self-
Evaluation 

The self-evaluation 
provides answers to 
the questions in all 
sections, an 
explanation for the 
answer and a 
general rating of 
each section. (5 
points) 

The self-evaluation 
provides answers to 
the questions in 
some sections, but 
not all, or some of 
the explanations for 
the answers or the 
general rating of 
each section are 
missing. (1-4  
points) 

The self-evaluation does 
not provide answers to 
any of the questions in 
all sections, an 
explanation for the 
answer and a general 
rating of each section. (5 
points) 

/3  
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